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General Description 
 

 
YESmanager remotely manages Affirmative Computer Products Linux-Based Terminals (LBTs) 
and Windows-Based Terminals (WBTs) connected to a local TCP/IP sub-net and/or to other sub-
nets. The software is installed on an NT/2000/XP machine and allows the Network Administrator to 
update terminal parameters and firmware. 
 
YESmanager can be used to manage the following Affirmative Computer Products terminals: 
• Model 2505 Linux Terminal (also requires a boot server) 
• Model 2509 Windows Terminal 
• Model 2611 Windows Terminal (CE 3.0 with firmware version 3.05NC build 1021 or higher) 
• Model 2611 Windows Terminal (CE.net with firmware version 5.00NC build 1024 or higher) 
• Model 2613 Windows Terminal (CE 3.0 with firmware version 3.05NCB build 1021 or higher) 
• Model 2613 Windows Terminal (CE.net with firmware version 5.00NCB build 1024 or higher) 
• Model 2613P Windows Terminal (Firmware version 5.00NCB build 1024 or higher) 
• Model 2614 Linux Terminal (Some features available only with firmware version 2.00c or 

higher) 
• Model 7331 Windows Terminal 
• Model 7332 Linux Terminal (Some features available only with firmware version 2.00c or 

higher) 
• Model 7370 YEStablet. 
 
YESmanager allows you to remotely manage almost all aspects of terminal management.  You can: 
• Automatically discover new terminals on the network. 
• Configure terminal properties. 
• Add, delete, and configure terminal sessions. 
• Clone terminal properties onto another terminal (Windows terminals only). 
• Upgrade terminal firmware. 
• Create and manage terminal groups. 
• Shadow and control terminal operation (Linux terminals, firmware version 2.00k or higher, 

only). 
• Reboot terminals. 
• Power down terminals. 
 

Return to Table of Contents.
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Installation 
 

 
The platform operating system must be Windows NT 4.0, Windows 2000 or Windows XP, desktop 
or server.  Note:  If a boot server (see step 12) is to be managed by YESmanager, Windows NT 4.0 
cannot be used.  
 
Installation of the Affirmative Computer Products YESmanager software is very simple; you can do 
it even while other applications are open on the server.  Install as follows: 
 
1. If the YESmanager software came as a compressed .zip file, extract the installation files to a 

convenient folder. 
2. If the YESmanager software came on a CD-ROM, the installation files will already be extracted 

in an installation folder on the CD-ROM. 
3. In the installation folder, run the file setup.exe from Start|Run on the desktop or by left double-

clicking on the file name. 
4. You will see a series of InstallShield setup screens.  The required entries are generally intuitive. 
5.  

 
Initial Setup Screen 

Click on Next to proceed, or Cancel to abort the setup. 
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6.  

 
License Agreement 

You must accept the license agreement by clicking on Yes to continue the installation. 
7.  

 
Customer Information 

Enter your customer information here. 
. 
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8.  

 
Destination Folder 

Choose the folder where the software files will be installed.  Typically, there is no reason to 
deviate from the default.  Since this folder probably does not yet exist on the computer, the 
installation software will create it after you click on Next. 

9.  

 
Setup Status 

You will see a status screen showing the install progress. 
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10.  

 
Final Setup Screen 

Click on Finish.  You do not need to reboot; the YESmanager software will be effective 
immediately. 

11. The first time that you open YESmanaager after installation, you will be faced with several 
configuration screens.  You must make some choices in these screens, but you can change 
them later from the Menu bar (see Operation|Menu Bar|Options) if you wish. 

12.  

 
Trees Configuration 

The only service available at this time is Boot Server.  This service is necessary only if you 
have some Affirmative Computer Products 2505 terminals, which use the BootOnLAN 
process, installed on the network.  Uncheck this box if you are not managing 2505 terminals. 
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13.  

 
Language Configuration 

Select a default language for terminal keyboards.  This can be overridden for individual 
terminals if desired. 

14.  

 
Browse Configuration 

YESmanager can be configured to automatically browse the network for active terminals.  
There are two parts to this configuration. 

a. Application.  This establishes the browser timing. 
• Refresh Startup.  If this box is checked, browsing will happen whenever 

YESmanager is opened. 
• Refresh Timing.  If this box is checked, browsing will happen every x minutes, 

where x is the time shown at the right and set by the slider bar. 
You can check both boxes if you wish.  If you leave them both unchecked, browsing 
must be manually initiated from the Tool bar or right-click option lists. 

b. Network Neighborhood.  This establishes the browser scope. 
• Broadcast.  Check this box to browse the entire local sub-net. 
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• Range IP Address.  If you wish to browse only part of the local sub-net, check 
this box and uncheck the other one.  Also, you may want to browse one or more 
other sub-nets as well as the local sub-net, in which case you check both boxes.  
The desired IP address range cannot be set here; see Operation|Menu Bar|Options 
for instructions on setting ranges. 

15. Click on Finish, and you are done. 
 

. 
Return to Table of Contents.
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Configuration 
 

 
Open the YESmanager program.  You will see a rapid succession of sub-windows that occur as 
YESmanager scans the network for boot servers and YEStation terminals.  Then you will see 
something resembling the following screen.   
 

 
YESmanager Screen with Collapsed Trees 

There are always two panes in the YESmanager screen.  The left pane shows the entities found on 
the network, and the right pane shows information about the entity highlighted in the left pane.  The 
screen shown above shows  “collapsed” trees in the left pane; clicking on the + sign for a tree will 
open it to show the next lower level of the tree. 
 

Boot Servers 
 
This tree contains all of the boot servers on the network.  You will see this tree if you chose Boot 
Servers on the initial opening of YESmanager (see the installation procedure). Boot servers are 
required to manage 2505 terminals.  If you don’t have these terminals on your network, you don’t 
need a boot server.  Management of boot servers is not covered here; see the 2505 Windows Based 
Terminal User Guide if you desire more information on this subject. 
 

Network Neighborhood 
 
This tree contains all of the manageable YEStation terminals on your network except for the 2505 
models.  Every time you open the YESmanager program, the local sub-net will be scanned for 
manageable terminals, and they will be listed under Network Neighborhood.  New terminals added 
to the subnet while YESmanager is active will “announce” themselves when they are booted up, 
and they will then appear under the tree.  After a terminal has been added to a tree, it will stay there 
until it is manually deleted, even if it is not currently communicating with YESmanager.  An active 
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(one that is communicating on the network) terminal has a small green light at the bottom of its 
icon, while an inactive terminal has a small red light. 
 
YESmanager can also manage terminals in other sub-nets, but they must be added manually or they 
must be specified in an IP address range or specified in a group sub-net address.  Groups can be 
created under Network Neighborhood, and sub-groups can be created under groups.  When new 
active terminals initially appear under the main Network Neighborhood tree, they can be moved 
into a specific group if desired (see Operation|Menu Bar|Modify|Move). 
 
For initial Network Neighborhood configuration, open the Options menu from the Menu bar, and 
then click on Options. 
 

 
Options Menu 

You will see the following window. 
 

 
General Options 

 

General Options 
 
• Auto Upload Configuration.  If the New Terminal box is checked, the configuration of a new 

terminal—one that was not previously on the terminal list—will be automatically uploaded 
when the terminal is first discovered.  If the box is not checked, the new terminal will be added 
to the list, but its configuration will have to be manually uploaded (see Operation|Drop-Down 
Option Lists|Terminals|xxxx|Configurations). 
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• Sort By.  These options affect the order in which the terminal list is sorted under Network 
Neighborhood and the session list is sorted under each terminal.  A type sort of devices lists 
Windows CE terminals first and then lists Linux terminals.  A type sort of sessions lists 



emulator display sessions followed by emulator printer sessions followed by RDP sessions 
followed by ICA sessions. 

• Check Device Status.  When the box is left unchecked, terminal status is checked only when 
YESmanager is first opened and when manually initiated through a browse or refresh 
command.  If the box is checked, terminal status will be checked periodically, with the period 
set by the slider bar.  

 

Trees Options 
 

 
Trees Options 

This screen duplicates the screen seen in the installation procedure.  You can change your choice 
here if you wish.  Leave Boot Server (the only valid service at this time) unchecked unless you 
have to manage 2505 terminals. 
 

Language Options 
 

 
Language Options 

 11



This screen duplicates the screen seen in the installation procedure.  You can change your choice 
here if you wish.  Select a default language for terminal keyboards.  This can be overridden for 
individual terminals if desired. 
 

Browse Options 
 

 
Browse Options 

YESmanager can be configured to automatically browse the network for active terminals.  There 
are two parts to this configuration. 

a. Application.  This establishes the browser timing. 
• Refresh Startup.  If this box is checked, browsing will happen whenever 

YESmanager is opened. 
• Refresh Timing.  If this box is checked, browsing will happen every x minutes, 

where x is the time shown at the right and set by the slider bar.  NOTE:  If you check 
this box, be sure to set the time to something other than the default 0 before you click 
on Finish.  If you don’t, YESmanager will get caught in an application error loop 
that can only be escaped by uninstalling and reinstalling the software. 

You can check both boxes if you wish.  If you leave them both unchecked, browsing must 
be manually initiated from the Tool bar or right-click option lists. 

b. Network Neighborhood.  This establishes the browser scope. 
• Broadcast.  Check this box to browse the entire local sub-net. 
• Range IP Address.  If you wish to browse only part of the local sub-net, check this 

box and uncheck the other one.  Also, you may want to browse one or more other 
sub-nets as well as the local sub-net, in which case you check both boxes.  The 
desired IP address range is set in the IP Range screen. 
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IP Range 
 

 
IP Range Options 

This screen shows the IP address ranges that have been established.  You can add a range, delete a 
range, or edit an existing range.  If this address range is being shared with a group (see Add A 
Group), a 1 will appear in the Shared Group column. 
 
Add 
 
Click the Add button to get the following dialog box. 
 

 
Add IP Range Dialog Box 

Enter the starting and ending addresses of the IP range to be managed under this group, and click on 
OK..  You can specify multiple ranges if you wish, as shown in the following window.  You can 
also enter a range of addresses outside of your local sub-net, as a way of adding other sub-nets. 
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Example of Multiple IP Ranges 

The screen shows an example of two sub-net address ranges that will be browsed.  If you want to 
delete one of them, highlight it and click on Delete.  You will be asked to confirm your action. 
 
Edit 
 
If you want to edit a range, highlight it and click on Edit.  You will see the following dialog box. 
 

 
Change IP Address Dialog Box 

Make your changes and then click on OK. 
 
 

Return to Table of Contents.
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Saving The Network Neighborhood 
Configuration 
 
It may be useful to save your Network Neighborhood configuration, so that replacement terminals 
can be easily configured.  When you do this, all details of the current configuration are saved, 
including groups, IP ranges, terminal properties, and session properties.  You can save multiple 
configurations if you wish.  The save process is:. 
1. Open the File menu from the Menu bar. 
2.  

 
File Menu 

Click on Export Configuration. 
3.  

 
Save Configuration File Dialog Box 

Choose the folder in which you want to save the backup file. 
4. Enter the name of the new backup file and click on Save. 
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5.  

 
Configuration File Save Confirmation 

Click on OK, and you are finished. 
. 
 

Return to Table of Contents.
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Restoring A Network Neighborhood 
Configuration 
 
You can restore any Network Neighborhood configuration that you have saved (see Saving The 
Network Neighborhood Configuration).  The process is: 
1. Open the File menu from the Menu bar. 
2.  

 
File Menu 

Click on Import Configuration. 
3.  

 
Import Warning 

Click on Yes if you want to save the current configuration before importing.  You will then be 
allowed to export the configuration, as described in Saving The Network Neighborhood 
Configuration. 

4. If you don’t want to save the current configuration, click on No. 
5.  

 

Open Configuration File Dialog Box 

Choose the folder in which you have saved the backup files. 
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6. You will see a list of backup files in that folder.  Highlight the desired file, click on Open and 
you are finished. 

All of the terminal configurations that you originally saved are now restored in YESmanager, but 
they are not yet loaded into the terminals.  To restore configurations on the terminals themselves, 
you must download the configuration for each individual terminal (see Operation|Option Drop-
Down Lists|Terminals|xxx|Configurations). 
 
 

Return to Table of Contents. 
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Add A Group 
 
For management purposes, it is usually convenient to group your devices by subnet or physical 
location like floor, department, etc.  Groups are especially convenient for managing terminals in 
other sub-nets, because a sub-net group can automatically be queried for any active devices 
whenever that group is browsed or refreshed, or whenever YESmanager is opened.  YESmanager 
cannot broadcast across sub-nets, so it must be aimed specifically at sub-nets or individual remote 
terminals.  
 
1. Right-click on Network Neighborhood to get a menu of options. 
2. Place the cursor on Add and you will see three Add options. 
3.  

 
Network Neighborhood Options 

Click on Group. 
4.  
 

 
Add Group Dialog Box 

Enter the desired group name and click OK. 
5. You will see the new group as a folder under Network Neighborhood.  If you are going to 

manually enter specific terminals into this group, you are finished.  Otherwise, right-click on the 
group name to get an options menu. 

 19



6.  

 
Group Options Menu 

Click on Properties to see a properties window with three tabs. 
7.  

 
Group General Properties 

Edit the group name here if you wish.  Then click on IP Range. 
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8.  

 
Group IP Range Properties 

This window shows the IP ranges that have already been assigned within Network 
Neighborhood.  If you want to use one of these IP ranges to define the group, click on the box at 
the left of the range.  If you want to assign a different range to the group, click on the IP Range 
button.  If you want to define the group by sub-net, skip to step 14. 

9.  

 
Modify IP Range Dialog Box 

Click the Add button. 
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10.  

 
Add IP Range Dialog Box 

Enter the starting and ending addresses of the IP range to be managed under this group, and then 
click on OK.   

11.  

 
Example of an Added IP Range 

You can specify multiple ranges if you wish, by repeating the Add process.  You can also enter 
a range of addresses outside of your local sub-net, as a way of adding other sub-nets.  Click on 
OK when you are done adding ranges. 
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12.  

 
Checked IP Range 

You must check the ranges that you wish to be active in this group.  If the ranges are not 
checked, they will not be browsed within this group.  In this example, only the third range will 
be browsed. 

13. You may want to adjust the Browse Delay, especially if you are browsing across routers. 
14. If you want to define the group by sub-net, click on the Sub Net tab. 
15.  

 
Group Sub Net Properties 

16. Check the Enable Sub Net Control box, and then enter the sub-net address and mask. 
17. Click on OK and you are finished. 
 
NOTE:  If a terminal is already shown directly under Network Neighborhood, it will not be 
automatically moved to a newly-established group, even if the IP range in that group includes the 
terminal IP address.  There are two ways to get the terminal into that group. 
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a. Delete the terminal from the Network Neighborhood list, and then browse (see 
Operation|Drop-Down Options Lists|Network Neighborhood) the group. 

Or 
b. Manually move the terminal (see Operation|Menu Bar|Modify|Move). 

 
 

Return to Table of Contents.
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Add A Terminal (Models 2505, 2509 
Only) 
 
You can add a Model 2505 or 2509 terminal directly to Network Neighborhood or to a group under 
Network Neighborhood.  But it is recommended that you use this process only if the terminal is not 
in the local sub-net and not in any specified IP range or sub-net 
 
1. Highlight Network Neighborhood or a group name. 
2. Right-click to get an options menu, and then click on Add. 
3.  

 
Add Windows Terminal Option 

Place the cursor on Add Windows Terminal or Add Linux Terminal. 
4. Click on the resulting YESwbt or YESlbt. 
5.  

.  
Add Terminal Dialog Box 

Ignore the terminal name, unless you need it for immediate identification purposes, because 
YESmanager will retrieve the terminal name from the terminal, when they communicate, and 
replace whatever name you enter here.  If you want to change the name, you can do it later from 
terminal properties (see Modifying A Terminal Configuration).  If the terminal is on a remote 
sub-net, enter the IP address of the terminal.  If the terminal is on the local sub-net, ignore the IP 
address.  Click on OK. 
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6.  

 
Example of an Added Terminal with No Name 

You will see a terminal icon with a yellow question mark, as shown in the above example.  
Right click on that icon and then click on Associates to device. 

7.  

 
Insert Device MAC Address Dialog Box 

Enter the last six characters of the terminal’s MAC address, and click on OK.  You will be 
asked to confirm your entry; click on Yes. 

8.  

 
Example of an Associated Added Terminal with No Name 

You see that the terminal icon now has a red dot at the bottom, even if the terminal is currently 
active.  This signifies that the status of this terminal is not yet known.  To “register” this new 
terminal with YESmanager, you can reboot the terminal, if it is on the local sub-net, or execute 
a Browse or Refresh on Network Neighborhood. 

9.  
 

 
Example of a “Registered” Terminal 

After a Refresh on Network Neighborhood, you see that the dot has turned green, and that the 
terminal has supplied the terminal name. 

10. Now, wasn’t that a pain, especially since you usually don’t have MAC addresses at your 
fingertips?  We recommend that you add terminals by specifying an IP range in the Network 
Neighborhood or group, even if that range contains only one IP address; this method will work 
for all the terminal models. 
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Add A Session 
 
When a terminal is first discovered under Network Neighborhood, the configuration of that 
terminal, including all terminal and session properties, is uploaded and stored by YESmanager.  
Subsequently, if that terminal is refreshed or browsed, only the active/inactive status is checked; 
nothing is uploaded regarding the configuration. 
 
If you want to add or delete a session, change terminal properties, or change session properties, your 
designated changes are made to the terminal configuration that is currently stored in YESmanager.  
Then you execute a Download to device action to move the modified configuration to the terminal.  
You will lose any configuration changes that may have been made by the user at the terminal since 
the last configuration upload.  So it is recommended that you execute an Upload from device 
before you make any changes. 
 
The recommended procedure to add a session is: 
1. Right-click on the terminal name to get an options menu, and then move the cursor to 

Configurations 
2.  

 
Terminal Configuration Upload/Download Menu 

Click on Upload from device. 
3. You will see several progress windows.  At their conclusion, the latest configuration for that 

terminal is safely stored, and you can view those configuration properties. 
4. Right-click on the terminal name again, and then click on Add in the drop-down menu. 
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The recommended procedure to add a session is: 
1. Right-click on the terminal name to get an options menu, and then move the cursor to 

Configurations 
2.  

 
Terminal Configuration Upload/Download Menu 

Click on Upload from device. 
3. You will see several progress windows.  At their conclusion, the latest configuration for that 

terminal is safely stored, and you can view those configuration properties. 
4. Open the terminal tree and right-click on the session name. 
5. Click on Properties in the drop-down menu. 
6. You will see a Properties window; its appearance will depend upon the type of session you are 

configuring.  For emulator sessions, the available configurable items are only subsets of those 
available for configuration at the terminal itself. 

7. Many of the properties are intuitive, but if you need help, please refer to the User Guide for that 
terminal model. 

8. After you have entered the desired properties, right-click on the terminal name to get an options 
menu, and then move the cursor to Configurations. 

9. Click on Download to device.  The new configuration will be downloaded to the terminal.  
NOTE: The terminal will be rebooted as soon as the configuration is downloaded.   

 
Emulator Global Settings 
 
When a terminal has multiple emulator sessions, some session properties are unique to each session 
and some session properties are global—they apply to all the sessions of that particular type 
(display or printer) that are configured on the terminal.  In 5250 display sessions, for example, the 
global properties consist of changes, from the default, to keyboard mapping, field attributes, hot 
spot definitions, keypad definitions, and macro generation.  These changes can only be made at the 
terminal; they cannot be edited, other than deleting them, from YESmanager.  However, they can 
be copied (see below) to other terminals. 
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After you upload a terminal configuration, you may notice a + in front of Emulator Global 
Settings for that terminal.  This signifies that one or more changes were made to the global 
properties of the emulator sessions. 
 

 
Example of Emulator Global Settings 

In this example, you see that changes have been made to field attributes, screen hot spots, the 
keypad, keyboard mapping, and macros.  You also see that if Macro is highlighted, the names of all 
the macros—in this case there is only one—are listed on the right.  If you highlight one of the other 
global settings, you will see, in the right-hand pane, the number of changes to that setting.  What 
you cannot see are the details of the changes. 
 
The beauty of listing these global settings in YESmanager is that you can copy them, in part or in 
total, to other terminals and thereby leverage the effort invested in creating the changes.  The copy 
procedure is: 
1. Right-click on the setting of interest, or, if you want to copy all settings, on Emulator Global 

Settings. 
2.  

 
Copy Keyboard Settings 
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3. Click on Copy to.  Note that you could also delete this setting at this step if you wished. 
4.  

 
Copy Dialog Box 

Select Emulator Global Settings under another terminal if you are copying one session.  Select 
the target terminal if you are copying all the settings.  Note that the OK button is only available 
if you select an appropriate target. 

5. Click on OK, and you are finished. 
 
If you are copying or deleting macros, you must execute on the entire list of macros.  You cannot 
copy or delete just one. 
 
 

Return to Table of Contents.
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Modifying A Terminal Configuration 
 
When a terminal is first discovered under Network Neighborhood, the configuration of that 
terminal, including all terminal and session properties, is uploaded and stored by YESmanager.  
Subsequently, if that terminal is refreshed or browsed, only the active/inactive status is checked; 
nothing is uploaded regarding the configuration. 
 
If you want to add or delete a session or change terminal properties, your designated changes are 
made to the terminal configuration that is currently stored in YESmanager.  Then you execute a 
Download to device action to move the modified configuration to the terminal.  You will lose any 
configuration changes that may have been made by the user at the terminal since the last 
configuration upload.  So it is recommended that you execute an Upload from device before you 
make any changes. 
 
The recommended procedure to modify a terminal configuration is: 
1. Right-click on the terminal name to get an options menu, and then move the cursor to 

Configurations. 
2.  

 
Terminal Configuration Upload/Download Menu 

Click on Upload from device. 
3. You will see several progress windows.  At their conclusion, the latest configuration for that 

terminal is safely stored. 
4. Right-click on the terminal name to get an options menu, and then click on Properties. 
5. The next window you see will depend upon the terminal model.  In general, the configurable 

properties in YESmanager are a core subset of all the possible terminal properties.  To 
configure the non-core properties, you will have to go to the terminal itself, or you will have to 
clone the terminal from a reference terminal (see Cloning A Terminal Configuration). 
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6. Many of the properties are intuitive, but if you need help, please refer to the User Guide for that 
terminal model.  We recommend that you change at least one property, terminal name, from the 
default.  This property can be found in the Network sheet of the terminal properties.  Otherwise 
it will be hard to identify individual terminals in the terminal list under Network Neighborhood. 

7. After you have made your changes, right-click on the terminal name to get the options menu, 
and then move the cursor to Configurations. 

8. Click on Download to device. 
9. You will see several progress windows.  At their conclusion, the new configuration has been 

transferred to the terminal.  NOTE: The terminal will be automatically rebooted after the 
transfer, so make sure you warn the user. 

 
 

Return to Table of Contents.
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Cloning A Terminal Configuration 
 
You may want to duplicate a terminal configuration on other terminals.  This can save you a lot of 
configuration effort and trips to the user sites.  This feature is not available for Linux terminals.  
The cloning process is: 
1. Create a source terminal with the configuration you wish to clone.  NOTE: This terminal must 

have the same firmware version as the target terminal. 
2. Upload the source configuration. 
3. Highlight the target terminal and place the cursor on Special Functions. 
4. Click on Configuration from… 
5.  

 
“Configuration from” Dialog Box 

Select the source terminal from the dialog box and click on OK.  NOTE: The OK button may be 
available even if the firmware versions are different, so you need to verify the source and target 
versions. 

6.  

 
“Configuration from” Options 
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• Replace.  Use this option if you want to completely replace a device, including the 

Terminal Name and IP address.  But you still have the option of changing the terminal 
name in the window under Data Device, and you can also change the IP address by 
unchecking From DHCP and entering an IP address. 

• Clone.  Use this option if you want to clone everything except the terminal name and IP 
address.  But you still have the option of changing the terminal name in the window under 
Data Device, and you can also change the IP address by unchecking From DHCP and 
entering an IP address. 

• Remove Source.  Check this box to remove the source terminal from YESmanager after 
the cloning process is complete.  You might want to do this if you are replacing, in order 
to avoid having two terminals in the Network Neighborhood list with the same name and 
IP address. 

 
 

Return to Table of Contents.
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Restoring A Terminal Configuration 
 
The restoration process differs between Windows and Linux terminals. 
 

Replacement Windows Terminals 
 
This procedure is for a terminal that is being put on the network to replace a defective terminal.  
Typically, the user or the network administrator will want the replacement terminal to take on the 
same configuration as the old defective one. 
1. Insure that the reference terminal configuration exists in the current Network Neighborhood 

configuration.  Even after that defective terminal has been removed from the network, it will 
still be in the Network Neighborhood list, and its configuration will be available, until the 
terminal is manually deleted from the list.  So leave it on the list unless unusual circumstances 
force you to remove it. 

2. If you can’t leave the old terminal on the list, save the current Network Neighborhood 
configuration (see Saving A Network Neighborhood Configuration) before you delete the 
terminal. 

3. Connect the replacement terminal to the network. 
4. If the old terminal is still on the list, go immediately to the next step..  If the old terminal is not 

on the list, do a save of the current configuration and then a restore (see Restoring A Network 
Neighborhood Configuration) of the configuration that you saved in step 2. 

5. Power up the replacement terminal. 
6. Do a browse to locate the terminal. 
7. Do a clone from the old terminal to the replacement terminal, as described in Cloning A 

Terminal Configuration.   
8. Download the restored configuration to the replacement terminal. 
9. If you had to save the Network Neighborhood configuration in step 4, restore it and do a browse 

to register the replacement terminal in that configuration. 
 

Default Windows Terminals 
 
This procedure is for terminals that are already registered in a Network Neighborhood 
configuration, but have been reset to factory defaults because of a firmware update or a 
troubleshooting operation: 
1. It’s a little late now, but you should have saved the Network Neighborhood configuration that 

contained the pre-default terminal configuration, as described in Saving A Network 
Neighborhood Configuration. 

2. Save the current Network Neighborhood configuration. 
3. Restore the configuration discussed in step 1.  This will automatically restore the pre-default 

configuration of the target terminal. 
4. Make sure that the target terminal is in the Active state. 
5. Download the configuration of the target terminal. 
6. Restore the configuration saved in step 3. 
7. Upload the configuration of the target terminal. 
 
. 
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Replacement Linux Terminals 
 
There is no way currently to save and restore a configuration to a replacement Linux terminal.  You 
will have to manually configure the terminal, either at the user end or via YESmanager (see Modify 
A Terminal Configuration). 
 

Default Linux Terminals 
 
This procedure is for terminals that are already registered in a Network Neighborhood 
configuration, but have been reset to factory defaults because of a firmware update or a 
troubleshooting operation.  NOTE: This procedure requires that there already be a saved Network 
Neighborhood configuration (see Saving A Network Neighborhood Configuration) containing the 
default terminal with the pre-default configuration. 
 
1. Restore the Network Neighborhood configuration containing the pre-default terminal, as 

described in Restoring A Network Neighborhood Configuration.  The pre-default configuration 
will automatically be applied. 

2. If the target terminal status does not show Active, browse Network Neighborhood to get the 
correct status. 

3. Make sure that the target terminal is in the Active state. 
4. Download the restored terminal configuration. 
5. If the original Network Neighborhood configuration was replaced in step 2, restore it and do a 

configuration upload of the target terminal. 
 
 

Return to Table of Contents.
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Updating Terminal Firmware 
 
One of the biggest advantages of remote central management is having the capability to update 
terminal firmware from a central location.  YESmanager provides this capability, but the process is 
slightly different for different types of terminals.  The common steps are: 
1. Download the new firmware file from the Affirmative Computer Products web site, 

www.affirmative.net.  This file will typically be in a compressed ZIP format. 
2. Extract the compressed files from the downloaded file into a convenient folder on any mapped 

drive, local or network.  For Linux firmware, this is a two –step process, since the first 
extraction will yield a file that is itself compressed; so you have to extract from this file also. 

3. Go to the specific section for the terminal operating system, Windows CE3.0, Windows CE.net, 
or Linux, for further instructions. 

 

Windows CE 3.0 Terminals (Firmware Version 
3.05NCx Build 1042 and above) 
 
NOTE: If the upgrade steps are followed correctly, the terminal configuration should not be lost 
during the Update process. But, for insurance, you may want to backup the configuration, as 
described in Saving The Network Neighborhood Configuration, before executing the upgrade. 
 
1. Right-click on the terminal name to get the drop-down options menu. 
2. Click on Firmware Update. 
3. If there currently are one or more active sessions on the target terminal, you will see the 

following warning. 
4.  

 
Active Sessions Warning 

If you answer Yes, or did not receive a warning, you will see the following dialog box. 
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5.  

 
Open Firmware File Dialog Box 

Choose the folder containing the extracted files. 
6. You should see a file with either a .bin or an .nkb extension.  If your extraction folder contains 

multiple firmware versions, you will see a list of such files.  NOTE: Execution of the next step 
should cause the terminal to be rebooted 

7. Click on the file for the desired version, and then click on Open. 
8.  

 
File Transfer Progress Box 

You will see this progress box.  If you click on Details while the update is progressing, you may 
see something resembling the following box. 

9.  

 
File Transfer Details 

Do not be dismayed by the error indications.  The upgrade will very likely be successful.  But 
there are still several more steps to execute. 

10. After the file transfer progress box disappears, you will see that the target terminal now shows 
an inactive status because the terminal is being rebooted. 

11. After the terminal has booted up, do a Browse on Network Neighborhood, or on the applicable 
group.  The terminal should reappear in an active state. 
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12. Restore the terminal configuration (see Restoring A Terminal Configuration) if necessary.  
Typically you should be able to do this by just downloading the pre-update configuration held 
over in Network Neighborhood. 

 

Windows CE.net Terminals (Firmware Version 
5.00NCx Build 1032 and above) 
 
NOTE: If the upgrade steps are followed correctly, the terminal configuration should not be lost 
during the Update process. But, for insurance, you may want to backup the configuration, as 
described in Saving The Network Neighborhood Configuration, before executing the upgrade. 
 
1. Right-click on the terminal name to get the drop-down options menu. 
1. Click on Firmware Update. 
2. If there currently are one or more active sessions on the target terminal, you will see the 

following warning. 
3.  

 
Active Sessions Warning 

If you answer Yes, or did not receive a warning, you will see the following dialog box. 
4.  

 
Open Firmware File Dialog Box 

Choose the folder containing the extracted files. 
5. You should see a file with either a .bin or an .nkb extension.  If your extraction folder contains 

multiple firmware versions, you will see a list of such files.  NOTE: Execution of the next step 
should cause the terminal to be rebooted 

6. Click on the file for the desired version, and then click on Open. 

 40



7.  

 
File Transfer Progress Box 

You will see this progress box.  If you click on Details while the update is progressing, you may 
see something resembling the following box. 

8.  

 
File Transfer Details 

9. Do not be dismayed by the error indications.  The upgrade will very likely be successful.  But 
there are still several more steps to execute. 

10. After the file transfer progress box disappears, you will see that the target terminal now shows 
an inactive status, even though the terminal might still be active as seen from the user end. 

11. The terminal should have rebooted by itself after the file transfer.  If you have nobody at the 
terminal end to report this, you can verify this by doing a Refresh on the terminal after waiting 
for enough time to let the terminal reboot; the status will show Active if the reboot was 
successful.  If it did, the terminal configuration should have been preserved, and you are done.  
If not, proceed to step 12. 

12. Have someone at the user end reset the terminal to factory defaults.  This will cause the terminal 
to be rebooted. 

13. After the terminal has booted up, do a Browse on Network Neighborhood, or on the applicable 
group.  The terminal should reappear in an active state. 

14. Restore the terminal configuration (see Restoring A Terminal Configuration) if necessary. 
Typically you should be able to do this by just downloading the pre-update configuration held 
over in Network Neighborhood. 

 

Linux Terminals (Models 2614 and 7332 with 
Firmware 2.00c and above) 
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NOTE: The terminal configuration may be lost during the Update process.  You may want to 
backup the configuration, as described in Saving The Network Neighborhood Configuration, before 
executing the upgrade. 



NOTE: If the target terminal has open sessions, you will not receive any warning, nor will the 
terminal user. 
 
1. Delete all the files in the htdocs folder of the YESmanager application program.  If you 

accepted the default installation location during the YESmanager installation, this folder is 
located in C:\Program Files\Affirmative\YESmanager. 

2. Move or copy all of the second set of the new extracted firmware files into C:\Program 
Files\Affirmative\YESmanager\htdocs. 

3. Right-click on the terminal name to get the drop-down options menu. 
4. Click on Firmware Update. 
5. You will be asked to confirm your intentions.  Click on Yes. 
6.  

 
File Transfer Progress Box with Details 

7. You will see a file transfer progress bar, with details if you clicked on Details. 
8. When this progress window disappears, the new firmware has been transferred to the terminal.  

Now the terminal will write the new firmware into the terminal’s flash memory.  During this 
process, which may take several minutes, the terminal video will be disabled and the terminal 
will appear inactive. 

9. After the firmware has been written into flash, the terminal will automatically reboot. 
10. After the terminal completes the boot-up, the terminal status will turn active again.  Now you 

can restore the terminal configuration (see Restoring A Terminal Configuration) if necessary. 
 
 

Return to Table of Contents. 
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Operation 
 

 

Drop-Down Option Lists 
 
Network Neighborhood and all entities under Network Neighborhood have drop-down option lists 
that can be accessed by right-clicking on the entity.  Most actions can be initiated from these 
drop-down option lists by clicking on the option.  If you see a right arrow to the right of any option, 
it means there are sub-options that can be accessed by placing the cursor on the option. 
 

Network Neighborhood 
 

 
Network Neighborhood Option List 

• Add.  This option allows the addition of a group (see Configuration|Add A Group), a Windows 
terminal (see Configuration|Add A Terminal), or a Linux terminal (see Configuration|Add A 
Terminal). 

• Refresh the Group.  This option checks the active/inactive status of all identified terminals in 
Network Neighborhood, including the identified terminals in any groups.  It also browses the 
local sub-net for any new terminals if Broadcast is checked in Options|Browse from the Menu 
bar (see Configuration|Network Neighborhood|Browse Options). 

• Browse the Group.  This option duplicates Refresh the Group, and also browses all specified 
group IP ranges and sub-nets for any new terminals.   It will also browse the local subnet and 
any specified IP ranges for Network Neighborhood itself if the appropriate boxes are checked in 
Options|Browse from the Menu bar (see Configuration|Network Neighborhood|Browse 
Options). 

• Properties.  This option is not applicable in this list. 
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Groups 
 

 
Group Options List 

• Add.  This option allows the addition of a group within a group (see Configuration|Add A 
Group), a Windows terminal (see Configuration|Add A Terminal), or a Linux terminal (see 
Configuration|Add A Terminal). 

• Delete.  This option deletes the group.  If you click on Delete, you will be asked to confirm your 
action. 

• Rename.  This option opens a dialog box allowing you to change the group name. 
• Properties.  This option opens a Group Properties window with three properties tabs.  See 

Configuration|Add A Group for explanations of the properties tabs. 
 

Terminals 
 
Available terminal options depend upon the type of terminal, Windows or Linux. 
 
Windows Terminals 
 

 
Windows Terminal Drop-Down Options List 
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Add 
 
Use this option to add a session to a terminal.  See Configuration|Add A Session for details. 
 
Configurations 
   
Place the cursor on this option to see to sub-options. 
• Upload from Device.  Click on this option to upload the latest configuration from the terminal.  

This option is used if you suspect that the user may have changed the configuration since you 
last obtained it. 

• Download to Device.  Click on this option if you have changed the terminal configuration in any 
way in YESmanager and want to apply those changes to the terminal.  If there are active 
sessions at the time, you will be given a warning. 

 

 
Active Sessions Warning 

After the download, the terminal is automatically rebooted.  The status will change to Inactive 
until you refresh the terminal, group, or Network Neighborhood status 

 
Firmware Update 
 
This option starts the firmware update process.  See Configuration|Updating Terminal Firmware. 
 
Special Functions 
 

 
Windows Special Functions Drop-Down List 
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• Factory Default.  Click on this option to reset the terminal to factory defaults.  NOTE:  If you 
exercise this option, someone at the user end will have to go through the Setup Wizard. 
• If there is an active session, you will be given a warning. 

 

 
Active Sessions Warning 

• If you click on Yes, the session will be closed, the terminal will be reset to factory defaults, 
and the terminal will be rebooted. The status will change to Inactive until you refresh the 
terminal, group, or Network Neighborhood status.  

• If there is no active session, you will be asked to confirm your action. 
 

 
Confirmation Request 

• If you click on Yes, the terminal will be reset to factory defaults, and the terminal will be 
rebooted. The status will change to Inactive until you refresh the terminal, group, or 
Network Neighborhood status. 

• Reboot. Click on this option to reboot the terminal. If there is an active session, you will be 
given the Active Sessions warning.  If there is no active session, you will be asked to confirm 
your action.  If you give an affirmative answer in either case, the terminal will be rebooted. . 
The status will change to Inactive until you refresh the terminal, group, or Network 
Neighborhood status. 

• Configuration From.  Click on this option if you wish to clone this terminal from a reference 
terminal.  See Configuration|Cloning A Terminal Configuration. 

• Send Registry.  This option is not available at this time. 
 
Associates to Device 
 
This option is only used if a terminal is manually added to Network Neighborhood or to a group.  
See Configuration|Add A Terminal for details. 
 
Delete 
 
Click on this option if you want to delete the terminal from the list.  You will be asked to confirm 
your action.  But note that deletion may be temporary.  If the list is browsed while the terminal is 
active, the terminal will reappear. 
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Rename 
 
This option does not apply to terminals.  But you can rename the terminal in the Network Properties 
sheet. 
 
Properties 
 
Click on this option and you will see something resembling the following window. 
 

 
Windows Terminal Properties 

The properties you see here are the properties that were stored in YESmanager when the terminal 
was last rebooted or when Upload Configuration was last executed for that terminal.  If someone 
at the user end has changed the properties in the meantime, those changes will not be seen here.  If 
you have doubts, do an Upload Configuration before looking at Properties. 
 
In general, the visible properties in YESmanager are a core subset of all the possible terminal 
properties.  To see the non-core properties, you will have to go to the terminal itself. 
 
Many of the properties are intuitive, but if you need help in interpretation, please refer to the User 
Guide for that terminal model. 
 
Refresh 
 
Click on this option to check the Active/Inactive status of the terminal and the configured sessions 
for that terminal.  A green dot at the bottom of the terminal or session icon signifies Active, while a 
red dot signifies Inactive.  Note that Refresh does not update the terminal properties if the user has 
made changes. 
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Linux Terminals 
 

 
Linux Terminal Drop-Down Options List 

Add 
 
Use this option to add a session to a terminal.  See Configuration|Add A Session for details. 
 
Configurations 
 
Place the cursor on this option to see to sub-options. 
• Upload from Device.  Click on this option to upload the latest configuration from the terminal.  

This option is used if you suspect that the user may have changed the configuration since you 
last obtained it. 

• Download to Device.  Click on this option if you have changed the terminal configuration in any 
way in YESmanager and want to apply those changes to the terminal.  NOTE: After the 
download, the terminal is automatically rebooted.  The status will change to Inactive until you 
refresh the terminal, group, or Network Neighborhood status 

. 
Firmware Update  
 
This option starts the firmware update process.  See Configuration|Updating Terminal Firmware. 
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Power Options 
 

 
Terminal Power Options 

NOTE: The terminal user will not get any warning before any of these options is exercised.  Also, 
YESmanager will not give any warning if there is an active session at the terminal. 
 
• Power On.  This option is not available at this time. 
• Power Off.  Click on this option to power-off the terminal.  You will be asked to confirm your 

action. 
• Reboot.  Click on this option to reboot the terminal without turning power off.  You will be 

asked to confirm your action. 
 

Special Functions 
 

 
Special Functions Options 
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• Factory Default.  Click on this option to reset the terminal to factory defaults.  You will be 
asked to confirm your action.  NOTE:  If you exercise this option, someone at the user end will 
have to go through the Setup Wizard.  Also the terminal user will not get any warning before 
this option is exercised, and YESmanager will not give any warning if there is an active session 
at the terminal. 

• Shadowing.  This option is available only with terminal firmware version 2.00k and above.  The 
screen resolution of the YESmanager platform should be at least as high as the shadowed 
terminal.  Shadowing must be enabled at the terminal in the Security tab of Terminal Properties 
for this to work.  If you try to exercise one of the two Shadowing options when Shadowing is 
not enabled, you will get an error message. 

o View Only.  This allows you to see the same screen that the terminal user sees. 
o Full Control.  This allows your keyboard and mouse to act as the terminal keyboard and 

mouse.  The terminal input devices can also be used at the same time. 
• Send Ini File.  This option is not available at this time. 
 
Delete 
 
Click on this option if you want to delete the terminal from the list.  You will be asked to confirm 
your action.  But note that deletion may be temporary.  If the terminal is rebooted, or if the list is 
browsed, the terminal will reappear. 
 
Properties 
 
Click on this option and you will see something resembling the following window. 
 

 
Linux Terminal Properties 

 
The properties you see here are the properties that were stored in YESmanager when the terminal 
was last rebooted or when Upload Configuration was last executed for that terminal.  If someone 
at the user end has changed the properties in the meantime, those changes will not be seen here.  If 
you have doubts, do an Upload Configuration before looking at Properties. 
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In general, the visible properties in YESmanager are a core subset of all the possible terminal 
properties.  To see the non-core properties, you will have to go to the terminal itself. 
 
Many of the properties are intuitive, but if you need help in interpretation, please refer to the User 
Guide for that terminal model. 
 
Refresh 
 
Click on this option to check the Active/Inactive status of the terminal and the configured sessions 
for that terminal.  A green dot at the bottom of the terminal or session icon signifies Active, while a 
red dot signifies Inactive.  Note that Refresh does not update the terminal properties if the user has 
made changes. 
 

Sessions 
 
The first level of a session option list is identical, regardless of the terminal type.  Note that none of 
the options you exercise here will take effect until you download the configuration (see Modify A 
Terminal Configuration). 
 

 
Session Option List 

• Delete.  This option deletes the session.  You will be asked to confirm your action. 
• Rename.  This option is not applicable for sessions.  But you can rename a session in the 

Properties option. 
• Default Connection.  This option is not applicable. 
• Automatic Startup.  This option will cause the session to automatically start up whenever the 

terminal is rebooted.  You will see a check mark by this option if the session has been set to 
automatically start. 

• Properties. The window that you see when you click on Properties will depend upon the type of 
session. The properties in this window are the properties that were stored in YESmanager when 
the terminal was last rebooted or when Upload Configuration was last executed for that 
terminal.  If someone at the user end has changed the properties in the meantime, those changes 
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will not be seen here.  If you have doubts, do an Upload Configuration before looking at 
Properties. 
• Depending upon the session type, the visible properties in YESmanager may be a core 

subset of all the possible session properties.  In such a case, you will have to go to the 
terminal itself to see the non-core properties. 

• Many of the properties are intuitive, but if you need help in interpretation, please refer to the 
User Guide for that terminal model. 

 
 

Return to Table of Contents. 
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Menu Bar 
 
The Menu Bar at the upper left corner of the YESmanager window provides another way to access 
many of the YESmanager options.  Some options can only be accessed through the Menu Bar. 
 

 
Menu Bar 

Highlight the entity of interest and then open the appropriate menu in the Menu Bar. 
 

File 
 

 
File Menu 

• Add. When you place the cursor on this option, you will see the second level of options.  It 
appears that you can do some senseless things, such as add a terminal to a terminal, but when 
you go to the third level, you will see that logic reigns and all inappropriate options are grayed 
out. 

 

 
Add Option 
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• Export/Import Configuration.  These options are independent of which entity is highlighted.  
They are used to save and restore Network Neighborhood configurations.  For more 
information, see Saving/Restoring The Network Neighborhood Configuration. 

• Remove All Groups and Devices.  This option is independent of which entity is highlighted.  It 
will remove everything in the Network Neighborhood list.  The groups will be lost, but you will 
see all the active devices again if you exercise a Browse on Network Neighborhood. 

• Remove All from Boot Server Tree.  If you select this option, you will be asked to confirm your 
decision.  Then this option will delete everything under Boot Servers.  But all active boot 
servers and terminals will reappear if YESmanager is closed and then re-opened or if you 
choose any of the browse or refresh options from the Tools menu. 

• Exit.  This option closes YESmanager. 
 

Modify 
 
The Modify options apply to groups, terminals, sessions, or boot servers, depending upon which of 
those you have highlighted.  Highlight the entity of interest, and then open the Modify menu.  The 
Modify menu items applicable to that entity will be clearly visible; the inapplicable items will be 
grayed out. 

 
 

 
Modify Menu 

• Copy.  This item is not applicable for any entity. 
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• Move.  This item is applicable for groups and terminals.  See the example below. 
 

 
Move Example 

In this example, we are moving TestGroup2 beneath Test Group1.  After we click on OK, we 
will see 

 

 
Move Result 

that TestGroup2 is now listed under TestGroup1.  This item is particularly useful in moving 
terminals into a specific group. 

• Rename.  This item is only applicable for groups. 
• Delete.  This item will delete, after confirmation, the object that you have highlighted.  But all 

active boot servers and terminals will reappear if YESmanager is closed and then re-opened or 
if you choose any of the browse or refresh options from the Tools menu. 

• Properties.  This item will display the properties of the object that you have highlighted.  You 
can also change many of the properties from the displayed properties screens. 
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Options 
 

 
Options Menu 

• Options.  Only the Options option is applicable, and it is applicable only for Network 
Neighborhood.   Click on Options to see this screen. 

 

 
Options Settings 

For details on using Options, see Configuration|Network Neighborhood. 
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Tools 
 

 
Terminal Tools Menu 

You will see a long list of tools that can be activated from the Tools menu, but some of them will be 
grayed out.  Which tools are grayed out will depend upon which entity in the left pane is 
highlighted; the grayed-out tools are not applicable for that particular entity. 
 
Most of these tools are also available from the drop-down option lists available when right-clicking 
on an entity.  But five are unique to this menu: 
• Browse Network Neighborhood.  This tool works exactly the same regardless of which entity is 

highlighted.  It checks the active/inactive status of all identified terminals in Network 
Neighborhood, including the identified terminals in any groups.  It also browses all specified 
group IP ranges and sub-nets for any new terminals.   It will also browse the local subnet and 
any specified IP ranges for Network Neighborhood itself if the appropriate boxes are checked in 
Options|Browse from the Menu bar (see Configuration|Network Neighborhood|Browse 
Options). 

Enable Log.  This tool works exactly the same regardless of which entity is highlighted.  Click on 
Enable Log to activate a text log that records the network activity in terms of refreshes, browses, 
and new terminals coming active on the local network.  When a log is enabled, there will be a 
checkmark beside Enable Log and View Log will be grayed out.  NOTE: The previous log will be 
deleted. 
• View Log.  This tool works exactly the same regardless of which entity is highlighted.  Before 

using this tool, you must un-enable Enable Log.  Then click on View Log, and a Notepad 
window will open with the text contents of the log. 

• NetOpenTracer.  This tool is not available at this time. 
• Upgrade “Windows CE Version”.  This tool is not available at this time. 
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View 
 
This menu allows you to control the appearance of the YESmanager window. 
 

 
View Menu 

Toolbars. 
Standard Buttons.  These are the buttons just below the Menu Bar.  When there is a check mark by 
Standard Buttons, the buttons are visible.  Left-click on Standard Buttons to toggle visibility. 
Address Bar.  This bar is just to the right of the buttons, or below them.  You can drag the left end 
of this bar to change its size.  When there is a check mark by Address Bar, the bar is visible.  Left-
click on Address Bar to toggle visibility. 
Status Bar.  This bar is at the bottom of the screen.  When a terminal or session is highlighted, this 
bar will give you a convenient look at IP address, MAC address, and firmware version.  When there 
is a check mark by Status Bar, the bar is visible.  Left-click on Status Bar to toggle visibility. 
Large Icons/Small Icons/List/Details.  These options control the appearance of items in the right 
pane.  Only one of these four view options can be active, as marked by a dot to the left of the name, 
at a time.  Click on the option of choice to invoke it. List and Details automatically invoke small 
icons. 
 

Help 
 

 
Help Menu 

 
There is no on-line help at this time.  Click on About to get information about YESmanager 
software. 
 
 

Return to Table of Contents. 
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Button Bar 
 
The Button Bar provides one-click access to several common options. 
 

 
Button Bar 

• Browse.  This button is only applicable for groups or for Network Neighborhood. It checks the 
active/inactive status of all identified terminals in the highlighted entity and all entities that are 
below it on the tree. 
• Groups.   In addition to checking status, it browses all specified group IP ranges and sub-

nets for any new terminals. 
• Network Neighborhood.  It browses all specified group IP ranges and sub-nets for any new 

terminals.   It will also browse the local subnet and any specified IP ranges for Network 
Neighborhood itself if the appropriate boxes are checked in Options|Browse from the Menu 
bar (see Configuration|Network Neighborhood|Browse Options). 

• Refresh.  This button is applicable for all entities.  It checks the active/inactive status of all 
identified terminals in the highlighted entity and all entities that are below it on the tree.  For 
Network Neighborhood only, Refresh will also browse the local subnet for any new terminals.. 

• Move.  This button provides exactly the same function as Move in the Modify menu. 
Copy/Help.  These buttons are not activated at this time. 
• Properties.  This button brings up the properties window for the highlighted entity, just like 

selecting Properties from the right-click menu.  You can view and change the properties from 
these windows. 

• Views.  This button brings up the Large Icons/Small Icons/List/Details portion of the Views 
menu.  These options control the appearance of items in the right pane.  Only one of these four 
view options can be active, as marked by a dot to the left of the name, at a time.  Click on the 
option of choice to invoke it. List and Details automatically invoke small icons. 

 
 

Return to Table of Contents.

 59



 

Status Bar 
 
The Status bar is located at the bottom of the YESmanager window.  Its visibility is controlled from 
the Views menu.  This bar only offers usable information if a terminal is highlighted in the left 
pane. 
 

 
Status Bar 

This bar offers four items of terminal information: name, IP address, MAC address, and firmware 
revision level. 
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Support 
 

 
Affirmative Computer Products offers Technical Support services for all the Affirmative products.  
You can access Affirmative Technical Support in one of the following ways: 
 
• via Phone 

o 480-946-1444 
o 888-353-5250 

• via Fax 
o 480-946-9250 

• via E-mail 
o support@affirmative.net 
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